Jen Goulden
Welcome to our Duxbury for Braille readers workshop. Thank you all for coming. We're glad you're here with us. I'm the past president of Braille Literacy Canada. My co-presenter is Jen Jesso, who is on the board of BLC. And Daphne Hitchcock is our moderator and note taker. And she's our vice president. And we also have Kim Kilpatrick, who is our secretary and the CCB rep. And she's going to be doing some live tweeting for us, to keep us in the social media world as we go through this. 
Jen Jesso is going to speak, I am going to hand things over to her, and she's going to get started. We’ve divided stuff up. She's going to talk for a while and give all sorts of useful information. And then we'll stop for maybe two questions, and then we'll go on to the stuff I'm going to talk about. We will keep most of the questions till the end just because with Duxbury there's kind of a lot to it. It’s likely that we're going to answer your question at some point anyway. So if at the end we haven't, then we will have some time to answer your questions. 
We’re going to ask if people can stay on mute. 
With that I am going to mute myself and hand things over to Jen. So that she can introduce herself and talk about all things Duxbury. 
 
Jen Jesso   
Thank you, Jen. My name is Jen Jesso and as Jen Goulden mentioned, I am a director on the board of BLC. And I have been a Duxbury user for about 15 years now. 

I'm just going to start this presentation talking about how to install it and set it up. And then I’ll go through some of the basic screen reader and Braille display features that you can use with it. This workshop is focused on Windows primarily, but there is a version of Duxbury for Mac. And I did find some information on the Duxbury website about how to install it and set it up with Voiceover. We are going to send out a resource document after this workshop. And a link to that Mac resource is included in the resource guide just in case you are a Mac user. I have never used it on Mac though. So, I can't speak to how well it works or what features might be available. But on Windows, I'm going to cover setting it up with JAWS as well as setting it up with NVDA. So whichever screen reader you're using, there will also be information in our resource guide about setting it up with that screen reader. 

With JAWS, it's fairly straightforward. When you install Duxbury It will ask if you want to install some Java scripts. And those scripts are really important to install because they basically are what give JAWS all of the features that it has. 
There was somebody at the very beginning who was asking about Perky Duck. And I will say that JAWS does work with Perky Duck, but I find it doesn't have quite the same support. For example, when you're moving through the document in Duxbury, you can choose how you want JAWS to speak each line, whether it's translated or whether it's spoken as Braille signs. And in Perky Duck, I believe you can only have it announced as Braille signs. 
So there are a few differences to pick, depending on if you're using the full version of Duxbury which is what this workshop is focused on. Or if you're using Perky Duck, which is a six key entry only program designed for students who are learning Braille. 
If you are using NVDA, there are no add-ons or scripts available that I'm aware of, to support Duxbury. One of the nice things about NVDA though, is that these things may be developed in the future, fingers crossed. But in the meantime, you do have to configure NVDA so that it works well when you're using Duxbury. And probably the easiest way to do this in NVDA is by setting up an application specific configuration file. This is a file with the certain NVDA settings that you've configured the way that you want that you can tie to Duxbury so that whenever Duxbury is launched, or whenever you press Alt Tab to set focus to Duxbury, NVDA will automatically switch to those settings that you've configured. 
And so the setting that's probably the most important, is turning off in NVDA, is Braille translation. Because if you have NVDA, translating your Braille display and you have Duxbury also translating, it's going to just end up as gibberish, that makes no sense. 
And so if you are using Braille files in particular, in Duxbury, you do want to set NVDA to computer Braille. And that will make sure that the Braille on your Braille display actually displays properly. One unfortunate thing is that it will also mean that all of the menus and dialog boxes and other areas including print files within Duxbury will all be displayed in computer Braille. 
I don't think there’s a way to tell NVDA to only use computer Braille when in a Braille file and to contract it in other areas of Duxbury. That's one limitation of this setting. 
Some other things you might want to set up are configuring NVDA, so that you have speech on or off. So NVDA JAWS, when you're using JAWS with Duxbury, it supports reading of the Braille files really well. You can use your arrow keys or navigation keys to move through those files. And JAWS will read it very nicely. NVDA does not have that support. So as you're moving through a file with speech, you're going to just get basically Braille ASCII spoken. So for example, it will, it will say the t-h-e contraction as an exclamation point, just as an example. And all of the different Braille signs have corresponding ASCII characters, which is what will be announced. 
Sometimes if you want to turn speech off and just use Braille with Duxbury that is something you also might want to configure and save to a configuration file. And we have all of these steps in detail on how to change these settings and how to save it as a configuration file in NVDA. In the resource document that we will be sending out, it's too long to go through every single step in this guide. 
Once you have your screen reader set up and Duxbury installed, and also, I should mention that this workshop is also assuming that you have already set up your Braille display with your screen readers. So, if you if you have a screen reader and a brand new Braille display just out of the box, that is something you will have to set up prior to doing any of what we're talking about here. Because it's your screen reader, of course that sends the communication about what is happening on your computer, to your Braille display. But what once you have Duxbury installed and any scripts that you need installed in any configuration that is needed installed. 
There are some ways particularly if you're using JAWS To get help if you are just starting out and learning how to use Duxbury. 
And so for JAWS, one of the most useful commands if you're just getting started is as soon as you launch, Duxbury will actually announce that you can get a list of JAWS hotkeys by pressing insert plus H. And if you do this, you get a very detailed list of basically every command available in jaws within Duxbury. 
In Jaws, it'll come up in the virtual viewer, and then you can use your navigation keys to read. And then one of the nice things too is that each command is a link. So, if you want to learn more about what that command does, you can press enter and you can read more about it. I don't know if it works on every single command. But for a lot of them, it will come up with additional information about specifically what that command does. So you can learn not only the command, you can learn what it does. 
And also, the j JAWS has built-in help. And Duxbury has built-in help. 
As Jen was mentioning, Duxbury is a really detailed program, and as is JAWS. And so if you want to, you can go into either of their help systems, and read more about particular topics that you're learning about. 
In our resource that we have detailed instructions on how to navigate the help system in both JAWS and Duxbury. They're both the same; they use the same commands to navigate. 
And the next section I have here is on using a Braille display with Duxbury. One of the things that you can do in Duxbury Braille files is that you can do Braille entry. And Jen is going to speak a little bit more about this, but I'm just going to address it in the sense of using a Braille display. So of course, a lot of braille displays have six key Perkins style keyboards on them that you can use to enter text in any area of Windows. 
So if you're searching for something online, or if you're sending an email, you can just type it in Braille. And just like the Braille output, your screen reader, when you type in Braille is translating that back into print for Windows. But if you are entering six key entry on Duxbury, into a Braille file, in particular, you don't want your screen reader to be translating that. 
So it is important to go in and configure the Braille display so that it is either translating or not translating and coming out properly as you're typing. 
I also find to in Duxbury, that it seems a bit contradictory, but you have to turn six key entry off to have the Braille display work in my experience, I'm not sure if that is intentional or not, because it's seems a bit opposite of what you would want to do. 
But that is something I have found that I have to do is to go in and just uncheck the six key entry in Duxbury. We have the steps on how to do that in our guide as well. 
And the other thing that you want, and this is more specific to NVDA, is you want to tether your Braille cursor to your system focus. So, in NVDA you have your system focus, and then you have a review cursor. You can tether the Braille cursor to either of those. And the reason why you want the system focus is basically your cursor within your file. And you need that to be tethered to your Braille because when you hit the bottom of a page, and you press you know the Next button or the down arrow, you want that to go to the next line within that page. And if you have your Braille settings tethered to focus, what will happen is you'll just end up with your Braille focused on the status bar at the bottom of the screen in Duxbury, rather than scrolling the page. So that is another setting that you want to go and change if you are an NVDA user, if you're a jaws user, the scripts take care of that you don't need to do anything really with Jaws, it's pretty automatic. If you install the scripts, everything for the most part is configured so that it will work well. And Jen is going to talk a little bit more about the user interface in Duxbury in a little while. And so, when you're navigating through either print or Braille files with a screen reader, most of the commands are the same. So if you want to navigate by letter, you would use the left and right arrow if you want to go by word you would use  Ctrl, left arrow or control right arrow. And same with line if you want up or down by line, you would use the up and down arrow. Navigating up and down by paragraph sometimes works and sometimes doesn't, it depends on what codes are used to create that new paragraph. It's so if it's you, if it's just created by, you know, hitting Enter twice and leaving a blank line, then it works fine. But if it uses some of the built in Duxbury codes or styles, it doesn't always work navigating by paragraphs. And other ways of navigating through Duxbury files are that you can jump to a specific page or line or column number, or all three of you have a very specific place you want to jump to. And you do that through the go to dialog, which is you can get to by pressing Ctrl plus G. And a dialog box will pop up with edit fields where you can enter in that information. And one of the nice features is  that if you are working in a file that has both print and Braille page numbers, you can pick whether you want to jump to the reference page, so the print page or the Braille page, and that is just a checkbox within that dialog that you would check or uncheck. And then as I mentioned earlier, there are a whole list of dos commands we can you know if people want, we can go into some detail if there's any questions about specific JAWS features. But you will access those with JAWS plus H and then there's a whole bunch of options within there. So as I mentioned earlier, when talking about perky duck, for example, you can toggle whether how you want JAWS to announce the Braille as you're moving through a file whether you wanted to basically read the translated line or read the Braille signs. So that is a specific command and you can toggle that on or off. And JAWS also has a quick settings area. This is something that jaws has for a lot of different programs and Duxbury is one of them. And to get to that you would press your insert or caps-lock. Depending on which key you have as your JAWS key, you would press either of those keys plus V, and that's going to bring up your quick settings. And in this area you can it has some settings that are specific to Duxbury. And then it has some that are just more general to JAWS. But regardless, all of them are saved basically to a Duxbury configuration file so that they only affect Duxbury. And so within that area, you can toggle some of these choices. And then they will stay toggled on or off depending on what you have picked. If you want for example, JAWS to always announce transit lines as you're navigating, you could go into quick settings and toggle that on and then it will stay toggled on always unless you toggle it off again. Whereas with the JAWS hotkey, it's just sort of a temporary toggle and I'm actually not sure if it remember sort of remembers that setting when you exit out and go back into Duxbury. So that is actually the end of my material unless people have any questions. And as I mentioned, there is a lot more detail in the guide that we are sending out. 
 
QUESTIONS from Participants to Jen Jesso
1. Peg Mercer   
Oh, just a quick question. I'm just curious whether any one knows if Duxbury works with Narrator at this point? 
Jen Jesso   
Yes Peg, I tried this because I wondered the same thing since I was covering JAWS and NVDA. I did not find it worked. It basically did read nothing within the Braille. So, you could access the menus but in terms of the actual file, it was just no speech whatsoever. 
 Peg Mercer   
And just does Narrator work with a Braille display? 
Jen Jesso   
Narrator does have Braille support. It's not as good as something like JAWS but it does have pretty decent Braille support. Microsoft has really improved on Narrator over the past few years. 
2. Kim Kilpatrick   
Peg read my mind because I was going to ask the exact same question. So, thanks for that. I have tried Narrator with a Braille display and it worked okay. And it used to be different drivers. So it's sort of messed up when you went back to another screen reader. But I don't know if that's changed now or not. 
Jen Jesso   
I had that same experience, Kim, which is why I haven't played around with it too much. 
3. Bruce  
As of July 2021, there are scripts for Duxbury built into JAWS, which ones would be more current? 
Jen Jesso   
I so when I wrote this document, I have JAWS 2021. would have been using the JAWS they built in scripts to JAWS. 
 
Daphne Hitchcock   
Great, thank you, Jen. If you have a question that comes out of this, and you want to just save that, and after Jen has finished her part of her presentation, we'll go back to some questions. Thanks so much. Jen Jesso for taking us this leg of the presentation Okay, Jen. 
 
Jen Goulden  
Thank you, Jen. We were talking at the beginning about how nobody uses Duxbury exactly the same way. A lot of people who learn to use Duxbury attend a workshop here and there, but for the most part, we kind of teach ourselves.  And then we go to Duxbury or when we when we have questions, we look things up online.  I find that whenever I do attend a Duxbury related workshop, I always end up learning something because I learned from somebody else's experience. And so I knew I would learn stuff from Jen and I totally did. So as she said, we're going to get some notes out to you, at some point next week, so that you'll have a little bit more detail. 
So that being said, I'm just going to jump right in; I have been using Duxbury for maybe eight years. I have certain things that I'm going to go through here, there ends up being a fair amount of overlap. So, there will be things that I will touch on that Jen has already covered. I'm not going to cover it again. But, for example, when we do the overview of the menu, Jen has referenced some things that are in the menus and she's talked about how to get there. I'm going to focus on things that we haven't actually talked about yet. 
I'm going to start by talking about how to enter text into a Duxbury file. And again, this is something that Jen has talked about. So I'm going to take a little bit of a different angle. When you're creating a Duxbury file, there are different ways that you can get your content in. One way is to import something like a Word file or even a TXT file. And when I go through the menus, I'm going to talk about this a little more. But basically, you've got your pre-existing content that you just pull into Duxbury, and there you go, you've got your text and then you can translate it, and you can do some formatting or whatever you need to do. 
The other thing that you can do is open Duxbury and start a new file and start a print file a DXP file. And when you do that, then you're just going to type on your keyboard, you can also type on your Braille display. If your Braille display allows for that you can enter text in the way you'd enter in any other document. 
And then the other aspect, which Jen has talked about is six key entry where you either turn off six key entry in the menu and use your Braille display or you turn it on and you use the letters of your keyboard, as Jen talked about FDS-JKL. I'll just say about six key entry that if you are either a Braille reader or quite comfortable with Braille, this is something that in the DXB, the Duxbury Braille file, do this a lot. I do a lot of manual format stuff that's already there, I import files, but when I need to change something, or there's just a sign that didn't quite come out right, but Duxbury is quite good. 
This doesn't usually happen, but I do a lot of manual a lot of six key entry because as a Braille reader, it's very easy for me to do it that way. Sometimes other people are more comfortable doing it in the print file and then translating it. That's just that's one reason why this is an option because sometimes it allows you to fix things that are a little bit more complicated to fix any other way. 
I think this leads on into talking about the different views and the user interface, I'm not going into too much detail, because when I go through the menus, I think it'll be a little easier to do that. 
One thing to note, about six key entry is that when you're searching for things, you can also use it. But let's say you're in your Duxbury file using six key entry, and then you have to save your file because you haven't saved it yet. And you need to enter the file name then you don't use 6 key entry. You just type as if you're like you're using a QWERTY keyboard, and you're typing in print. Every once in a while, I go to type something, and I just get this mass of letters; I remember, oh yeah, I can't use 6 key entry here. So you just keep an eye on what you're what you're doing. 
That being said, I'll just quickly explain what we mean by the user interface. Jen talked about this already, she talked about coded codes and styles and coded view. 
So there's different views that you can have opened depending on what you're doing. And I think when I go through the menu, I'm going to get to the View menu. And that's where the different views that you can choose from, that's where they are. We'll come back to that a bit. But it's just helpful to look at codes and styles, because then you can see what's going on behind the scenes. To give you a really quick example, I was working on a file one time, and I was trying to get rid of a blank line, there was an extra blank line that that wasn't needed. And I was trying to get rid of it. I'm backspacing, and I’m backspacing, and it's not going away. So when I switched into code view, there was there was a code, I don't remember whether it was the lists style that automatically has a blank line built into it, or it was like an extra line, a line code to put in a skip a skip line. Once I could see that the code was there, I could put my cursor after the code and backspace and get rid of it. 
But sometimes when you're in just the regular Duxbury view, you see what it looks like, but you don't see why it looks the way it does. And so that's why the codes and styles can be can be really helpful; Alt F3 toggles it. You can toggle the view on and off. 
One thing that comes up in the menus is that there's some of the different views; you can view the print font, , this view is sort of more helpful for sighted people, they may want to look at the actual print letters, it's definitely when you're in a print file, this is sort of what you want to what you want to do when you're your other options are Braille and some Braille. And if you are new the these views, views will allow you to either see like graphical dots, or you can also see the ASCII Braille. 
The example Jen gave where the t-h-e sign is an exclamation mark. Duxbury gives you a lot of flexibility to choose how you want to be able to see how you want to have the content presented to you. 
I think what I'm going to do it at this point in my notes, I'm going to go through an overview of the menus, but I think I'm just actually going to before I do that, I'm going to talk a little bit about codes and styles. And then and then we'll, we'll go back to the menu. 
Jen and I were talking earlier we were thinking that we could do an entire session just on codes and styles and templates, because there's really a lot that you can do for anyone who's familiar with word styles. It's kind of like that in Duxbury. But Duxbury really lets you get in and do all kinds of things with styles according to Braille formatting rules. 
So what I want to do is just give a bit more of an overview, before we go into the menus on how they work. And some things that you might want to kind of keep in mind. The best way to think of codes and style so a code is going to do one thing. I mentioned line codes as a code. An example of a code might be to just add an extra line; it will add another line, put you on the next line. A style is basically a bunch of codes all together that will work all at once to kind of set up a certain formatting. A good example is to think about the list style. We all know that in Braille, that we have paragraphs that are indented, and then they run over to the left margin. And we have lists where each item starts in the margin and wraps to cell three. When you apply the list style in Duxbury, it's doing a number of things, it's inserting a blank line before and after the list. It's causing the text, it's causing each list item to start at the left margin, and it's causing the run overs to be in cell three. So right there, that's kind of three things that the style is doing. 
So you've got codes, and then you've got a style, which is a bunch of codes. And then you've got a template, which is a bunch of styles. If you have used Duxbury, you know that when you open it, you have to choose your template. So part of choosing your template means you have to pick your language, what Braille code you are using, is it going to be contracted or uncontracted. And then in each template, there's a whole bunch of styles that you have access to, so that you can control what the output looks like. When you're looking in coded view, which is what it's called when you do Alt F3, then you can see all the codes. 
One thing that you'll notice is that codes are in square brackets and styles are in less than and greater than symbols. If you are not sure whether something is a code or a style, you can tell even just by that. For example, an H1 is a style because it's going to center your text, it's going to make sure there's a blank line before and after it. It's got a couple of different codes in it that will make it look like a centered heading. Each of these things will have a begin a beginning and an end. 
Let’s say, for example, the list style, you'll the actual style is L dashed list. You will have L dash list, and then you'll have all your actual list content. At the end of the list it will say in less than and greater than symbols, slash L dash list.
My apologies if this sounds a little overwhelming, don't feel like you have to memorize this, I just want to let you know what you're going to see if you start looking at a file with coded view on. One thing that you have to bear in mind is that there's the ‘begin style’ and ‘end style’ and that everything between these two things is going to be according to this format. If you with your cursor, get rid of the ‘end style’, it's going to automatically get rid of the ‘begin file’ as well. So that all that formatting will go away. You have to be careful when you're getting rid of things that if you delete the beginning or the end, it's going to automatically delete the other one for you. 
I thought I would just give an example or two of when I use coded view and find it very helpful. If I'm setting page numbers, I sometimes if I have to from transcribing a document and I have to set the T pages right the front matter transcriber pages, and then you do that and then you have to when the body of the document starts, and you have to get rid of the T and just have regular page numbers. There's a code that will do that. But it has to be in a very specific spot on the page, it has to be pretty much the first code on the page, or else it will get sucked into another style. I've done this before, I've tried to put the code in and found out that it was in the middle of the H1. And it's within that style; so Duxbury doesn't see it and so it doesn't do it. 
I didn't know that and it took me a very long and lots of frustration to figure that out. In the encoded view, you can actually see where your heading styles start; you can put your cursor in the right place so that you can enter this code. 
I think I probably should have said earlier is that when you're entering codes and styles, I'll show you how to do this on the menu, you can just go in and do it you don't have to memorize them all. But you can enter them manually if there's some that you do a lot that you do often. Sometimes it's easier just to know it and to go in and enter it instead of going to the menu and finding it. It just it gives you gives you the option. 
And the last thing that I'll say about codes and styles is that when you're applying styles, even if you're just you're going to go to the menu, it's important to remember all of the things that that the style does. 
And again, I'm going to use the list example because sometimes you might be doing something where you want to have your text started the left margin and wrap to cell three, and you want that indent to happen. But you for whatever reason, you let's see, I'll do it the reverse way. Let's say that it's it is kind of a list format, right? It starts as I want to grab cell three. And so there is a style, there are style options in Duxbury. They don't have names, they're numbered. So they're like 1-1, 1-3, 1-5. And what it means is starts in cell one wraps to cell one, starts in cell one and wraps to cell three, etc, etc. You can pretty much force any kind of formatting. 
So let's say you have your list and you decide you're going to use the one-three style to make it look right.  Well, that's great, and it will do it. But what it won't do is insert the blank line that goes before a list and after a list because that's not part of that style. So you will need the list style, which will format your Braille correctly and it will also include the blank lines. 
I say this, just to illustrate the fact that when you're using styles, just remember that part of what makes them a style is that they do more than one thing. You need to kind of think about what you really want it to do before you apply that style. A lot of it is trial and error, I certainly didn't memorize all this stuff, I just kind of learnt it by doing and I suspect that's how it be for most of you as well. 
You can also add styles to your template, you can create new ones, you can modify existing ones. We could do a whole separate session on styles because it can get pretty detailed. 
That being said, I'm going to go through the menus now. One of the things about the Duxbury menu is that if you're familiar with Word with Microsoft Word, it's very similar in a lot of ways. If you're comfortable with it, or for that matter if you're not comfortable with it, don't be alarmed, it is fairly intuitive. The more you play with it, you'll get used to it. 
So there's the File menu, which is like Word has; you can create a new file, you can open existing file, you can ‘save’, or you can ‘save as’. 
‘Save As’, this is one of the things where you would go if you wanted to keep your file, but change the name or that's where you go if you want to save as a BRF file, ready files that you can look at. 
So you can read it on a note taker for example; there's print, there's emboss, this is where you can translate a file. 
If you're in a print file, you can do Ctrl T, or you can go to this menu and translate your file, it will also let you it can also let you back translate. But this is one thing I discovered about the back translate feature is that if you're in a Braille file, and you try to do Ctrl T ducks doctor is going to go ‘Hello, you already translated this file’, so you're going to translate something that's already translated. But if you go to the File menu and click on translate, it will actually go back to a print file. 
Going to the Edit menu, Jen talked about a number of things on this menu already, so, I'm not really going to touch on this. However, the only thing that I wanted to mention is the ‘insert File’ option. This is a really cool option; if you are transcribing a file and you have to add in like a title page and a special symbols page, and you've already got one that you create a for a different file, then you can pull that in and then maybe make any changes that need to be made, instead of doing it from scratch. You can insert it in here, by clicking on Insert file and it'll give you like a dialog box where you can go and select the Duxbury file that you want to insert. 
You can do this with print files and you can do it with Braille files, but it has to be the same; if you're in a Duxbury Print file, you have to insert a Print file and if you're in a Duxbury Braille file, you have to insert a Braille file. 
And if you are in a Duxbury Braille file and you decide you want to just copy and paste another file in without using this option, you can do it but you have to open another window within the Duxbury window you're already in; you do Ctrl o and open it, you can't go to Duxbury again and open it separately and then copy paste, so it won't, unless that's changed it in 12.5, and done it a long time because it just it never worked. So I always just do insert file. Again, this is something you can kind of play with and see how it works. 
If you do need to search for codes and styles, you have to be in code view and you would hit F9 or alt F9 depending on whether you're looking for a code and the style. And you can enter the text of this, whatever the style is like L dash list and probably you have to also insert the symbols that go around the style. 
I apologize if this is getting a bit technical. But I mentioned earlier that styles are within less than and greater than symbols, you have to insert those into the find box. And you have to, I always forget the order of how this works. But I think you would do Ctrl F like find and then you hit F9. And it actually puts the symbols there for you. And then you type it in. This is a little complex, and it would be easier to demonstrate it. But maybe if Jen and I do the codes and styles workshop, we can go in more detail. I would just encourage you to, if you own Duxbury just play with it, and you'll get to see how it works. 
To keep us moving along, we're going to go to the View menu. And again, Word also has a view menu. And this is one that will change, and give you the different views that are possible. I find that a lot of these views are a little bit more beneficial for sighted people that are using Duxbury because you can click on the full page view which it will make the font smaller, but it will show your entire page of text, so you can see the formatting. For Braille readers using a display,  we're seeing one line at a time and we're scrolling anyway, so it doesn't really make a difference for us. 
Here's where we talked about print font, braille font or sim-braille. If you want to view ASCII Braille or graphical dots, if you choose sim-braille, then it will be the graphical dots. But there'll be the shadow dots. It's, again, easier for people who are looking at this visually. This is why I always kind of mix up which one does which but this is where you would go to click on six key entry. This is where you would go with if you didn't want to memorize the toggle to activate coded view, you can go here and click on it. 
Now I'm going to go to the layout. The layout tab is in the menu and this has all kinds of fun stuff in here; this has a code list. So you are in the Layout menu, you just would hit enter on code list. And then it's got all kinds of things like, accented characters, line codes, a code written to skip lines, codes where you can force things; words to stay together or where you can force them apart. There are different symbols like the pound sign and the euro. And there's all kinds of things in here. Again, some trial and error in the Help menu that Jen talked about. Duxbury does provide a code, a code list quick reference, I think it's on their website as well. 
Also on this menu you can apply style so when you go on this menu and you click on Apply style, in the template that I'm using the banner, UEB, English, English, UEB banner, whatever it's called. There are 131 styles that I can choose from everything from the formatting ones I talked about, like 1-1,1-2, 1-3, etc. There's one that you can apply that basically will uncontracted an acronym there's, there are styles that will force text to and contract.
If for whatever reason when you're transcribing an English document, but there's some French words and you want it to use French accents instead of UEB accents. You can go in here and you can type the first letter of the style like French, F for French, and it will take you there. 
I learned by trial and error, there were some styles that you know, H1 heading centered, well, that was kind of obvious that it was an H1, centered heading. But some of them I don't know what they do, so I just try it in a document and see what happens. 
There are different ways to get to that menu too, you can go to the menu the way I just did. Or you can also do F8, it takes you to the styles lists, you can just choose the one you want. There are a lot of things in this Layout menu, you can apply the last style, if you don't want to have to go searching for it again. There are a number of other more complicated things. You can change the style level and not all styles. This isn't relevant to all styles. But for example, the list style, if you're doing the list style, then you realize that you've got a multi-level list and you need to change the indent, you can hit style level plus, or let's say you put too many levels in your listing and it should only have one sub item instead of two, you can go to list and hit style level minus, or you can also combine styles, you can combine lines. I don't want to get too convoluted because you don't really have anything in front of you that you can follow along. But it allows you a lot of flexibility to work with the formatting of your document, you can change the translations. 
If you're working in a contracted document, you can force on contraction; there's different ways of doing that. There are character and line codes, you can set the margins, you can set run overs. There are math codes that you can enter page code. So you can force a new braille page for the new print page. You can vertically center your content.
The layout menu, it's really what it sounds like. It's page layout. You can set running header, you can generate a table of contents. This is a really great if you're doing a document of any length, even documents that you're translating from Word and that they already had a content table of contents in the print one, you can get rid of it and just generate one in Braille. And you can tell Duxbury that you want it to create the contents using Braille page numbers or print page numbers, whichever you choose. It does a really good job and it's super fast. 
You have to do it when you're done the document. Let’s say, that the table of contents says a certain heading is on page seven, and then you go and you do a whole bunch of changes to your document and then your heading has moved onto page eight, but your table of contents still says it's on page seven. This is really one of the last things you want to do. 
You can insert tactile graphics. There's a table menu, which allows you to either create a table, or if you've imported a table, let's say from Word it'll let you change the way Duxbury sets it up. If you have a Word document and it's got a table in it, when you pull that file into Duxbury, Duxbury is going to format it and sometimes it's right, and it does a really good job. And other times, it looks kind of a little bit of a mess. And so, you have to go in and choose from the different table types. You can do listed tables and linear tables, those of you who are a little bit more familiar with official Braille formats may be more familiar with different table types. But again, I would recommend if you're transcribing something, try your table different ways and see what it looks like because sometimes you don't really know what's going to be the best option until you actually do it.  
Duxbury, just like other programs, allows you to make changes that will apply only in the document that you're in and then it also allows you to make global changes and some of the same settings are in both. For example, embosser setup index varies document menu, you can set up an embosser. If you want to change something just in this document, if you want to change any printer settings, any page number settings, there's a bunch of things that you can change, the only thing I'm going to focus on and that's the same for the global menu as well. 
If you want to actually set up an embosser from scratch, like you've never used an embosser with Duxbury, then you have to go to the global menu and set it up and you add your embosser. And Duxbury walks you through the process; you select your embosser, you select your version, and you configure specific things, some of them are specific to the embosser. I'm not going into this in a lot of detail, because it will depend on your embosser. But if you just go through the menu, Duxbury walks you through and tells you what it needs. 
You need to decide whether you are printing double sided, which is inter-point. 
One thing about this before I forget, is that before you configure your embosser in Duxbury, you need to set it up, to add it in your Window Settings. Or if you're using a Mac, the same thing applies. On a PC you have to go into your control panel, add printers and devices and add your embosser there before you can add it in Duxbury. And then you will need to learn about your specific embosser. But this is where you would set it up in your global menu in Duxbury, you go into embosser settings. But on the document menu, that's where you're going to go into embosser setup, it's going to let you choose the paper size. Let's say you normally use 11.5 by 11 paper, but in this particular document, you want to use a smaller paper size. Let’s say in the document you changed the line lengths, and maybe you changed the margin or whatever, but it's just going to be for that specific document. Duxbury usually warns you if you try to change something that it thinks you might have meant to have changed in the global settings, it's going to tell you that something is going to affect in this document. So let's move to the global menu. I've already mentioned that this is where you can configure or actually set up your embosser. This is also where you can decide how Duxbury wants to import files. 
I've already talked about importing Word files, basically, while in Duxbury, you hit Ctrl O or you go to the File menu and hit open. And then you can go through the files on your system and choose a Word file and open it in Duxbury. And it'll open a Duxbury print file and then you can translate it to Braille. And if it's been properly formatted in Word, it will actually turn out quite well. Duxbury in Word can play pretty nicely together. But in the global menu there are different options for how you import Word files. I'm not going to go into too much detail but you can tell Duxbury what you want it to do with page breaks in Word, what you want it to do with hyperlinks. Or let’s say, text that is bolded or underlined, you can tell it either to keep that or you can tell it to ignore it. There are a bunch of things that you can decide on how you want Duxbury to handle the information that gets from Word. 
There is also the formatted Braille importer; if you have a BRF file, I'm sure most of you are familiar with a BRF file, but it's basically a text file that has ASCII Braille. and it's on your note taker you can import that into Duxbury. And you can either tell Duxbury don't do anything to this file, just import it and keep everything the same. O you can tell Duxbury, here's where the page numbers are, and there's running headers on he odd pages; you can tell Duxbury how you want it to process that file. 
And I love that Duxbury still has a Word Perfect importer, which I just think is great. So you can also set up a printer. Also Duxbury auto saves, so if Duxbury crashes on you, it will save your files. There's international level that allows you to set different or change the interface of the menu. I have mine set to English but you can actually set a French menu or Spanish menu or whatever languages. Duxbury supports, and produces something like 130 languages, and they're adding to it all the time. One of the reasons why Duxbury is so prevalent around the world is because it can do so many different languages. 
And this menu, you can also choose the font size that your print files appear in and you can set your fonts. I'm not going to go into the detail about the view preferences and different things you can do. But you can really, you can go into this global menu and configure how you want to view Duxbury and what you want your default settings to be. 
I forgot to say in the document menu, is where you can create templates of your own. And, again, in creating templates, I would recommend that you become comfortable with codes and styles before you get into doing more of that stuff. But definitely play with it because that's really the best way you learn. 
Jen talked about the Help menu. If you're not sure about what something in the menu does, go into the help part of the menu and click on the menu, there's a section called the menus. And it'll tell you what every single thing in the menu thing does. 
The last thing that I'm going to talk a little bit about is using Swift with Word and Duxbury. In Word, if you have Duxbury on your system and you're running, I think you need like at least Word 2007,  you can download and add in, a plug-in, in Word that's basically, a Duxbury tab on your menu. It allows you to do all kinds of things, and apply a whole bunch of Duxbury styles in your Word file. 
So normally in Word, if using MS Word, you can create headings, H1 and H2, and Duxbury will understand that, and it will produce it. It will transcribe it properly. But if you have this add in, you can actually do things like enter a transcriber’s note style in your Word file. You can do things like format it in 5-7.
You can format it to do all kinds of things within the word file. And then when you go to Duxbury, you pretty much just proof read your work and make sure it did what it was supposed to do. I know of transcribers who pretty much do all of the transcription in Word. This is how they do it. They use the Duxbury add ins and all this kind of thing in Word. They do everything there. And then they just put it in Duxbury and you know, kind of look through it. And then it goes to a proofreader. 
This goes back to my comment about how everybody uses it differently. I would say for me, just to give you an example, if there's a table and it's kind of a mess, I'll fix that in word because I find it a bit easier to do. But for the most part, I like to work in Duxbury. And I actually really like to work in the Braille file, because then I'm looking at it, the way it's going to the way the output is going to be for me, I don't know if that's just because I'm a Braille reader, probably it is. 
So that's something that you can do if you're doing transcription, whether you're doing it professionally or whether you just want to be able to create your own documents. You can decide how much of the work you want to do in Word, how much of it you want to do in the Duxbury print file, how much you want to do in the Duxbury in the Braille file.  There are some things that you have to do in the print file, such as applying the French language style in the midst of an English document, you have to do it in the print file. Sometimes there are certain styles that won't work in Braille, because you're totally changing the Braille output. The formatting styles will work in Braille, but sometimes code changes, like language will only work in the print file. So you need to do a bit of trial and error and be mindful of that. I'm going to stop there. Jen, is there anything that you want to add that I to say or that came to mind? 
 
Jen Jesso   
One thing I do want to add, there are three ways of working with files; you can work with in Word you, can work in Duxbury print view, or Duxbury Braille view, I tend to work in Duxbury print view, with codes turned on all the time. But one thing I did want to say is that in the Duxbury, there is a place in the menus where you can, if you have styles that you insert all the time or codes, you can tie those to a keyboard command. I think by default, for example, a new page is Ctrl, and enter. But you can actually go in if you wanted to change that to something else. And I think there are four or five or six different keyboard commands that you can tie to style. So if you're using a style all the time, you don't always have to go in through the menus to insert it. 
 
 
Jen Jesso   
In terms of Swift, I think one of the advantages of working in Word is that they let you tie commands to absolutely everything. So you could go through that entire customized ribbon that Duxbury inserts in there and you could tie a keyboard command to every single style in there if you wanted to. The main advantage of that is, if you're already super familiar with Word and you, you know all the keyboard commands, I think, in some cases, you can do things a lot faster, but you do have to proofread because it's not always perfect when it imports so. 
 
Jen   
One of the things about Duxbury that I like, it is really, really good with the code. Like there's certain words and, you know, anybody who does a lot of work in Duxbury well know there's certain things that doesn't quite get right. And there's certain You know, there's manual intervention that's required, but 
It actually does a really, really good job with importing the text and getting the proper Braille output. It does a really good job with formatting too. But if your Word input file has a lot of problems, your output file in Duxbury may have a lot of problems. I referred to tables, so if you have all kinds of merge cells, Duxbury does not like merged cells and columns and things. So that's when I was talking about a table being a mess. And going into Word, I actually find it a lot easier to fix to clean up tables in Word than I do, than I do in Duxbury. 
Daphne Hitchcock   
Thank you Jen and Jen for all this detailed information. It's fantastic. We're looking for questions. 
Questions from Participants
Diana Brent   
Okay, I discovered for anybody that wants to use a computer keyboard, and use the SDF JKL, there's been a long standing issue that newer keyboards often don't work properly. And so everybody runs around and looks for the old ones that are in their basement or wherever. But the  thing I discovered by contacting Duxbury this summer, is that if you go into the global menu, into the View menu and preferences, there's a way you can change the keys on your bottom row of keys. And I know at least two people that were doing this, made it work. And for both of them, those keyboards worked by changing those keys. So if somebody is using a keyboard and having trouble with it, that's something to try. 
Jen   
That's awesome. Thank you. I did not know that. The other thing, actually, you brought up something that I should have mentioned, because when you open Duxbury, if you just open Duxbury, but don't open a file, when you pull up the menu of there, it's going to let you it's all sorts of global settings. So what Diana was just talking about, about going into the View menu, like view in the global menu, that's what she's  talking about, not within a document she's talking about, just open Duxbury and then go to the View menu without opening a document.  
Diana Brent   
Yeah, that's, that's true. And I would, I use some file, but I don't use a lot of them. Because I I'm old enough, and have used Duxbury long enough that I hand crank a lot of things, using line styles and things that I'm probably not supposed to, but the format works. So I would love a styles workshop to get into it. 
 Jen   
Great. Well, thank you for that feedback. And thank you for that tip about the keyboard. 
 Peg Mercer   
Just a quick question about the styles you were mentioning earlier about manually inputting a style, like the coded style symbols at the beginning and then doing your text and then somehow closing it for me. I'm just wondering if it's safer to select your you want to have in the style? And then go into the styles menu and find the style that it would apply to? Because I'm just wondering to doing it manually, you have to be sure to close it right, I guess you would arrow to the right of where you want to close your style. 
 Jen   
I find it easier to do what you suggested I just go to the menu, I rarely ever, like some styles. And this is I won't go into too much detail because I want to leave time for more questions. But some styles, you just have to have your cursor wherever you want it to be. And then you can apply the style other things, you have to highlight the text. So, Duxbury knows which text needs to be in the style, right? Either way, you put your cursor in the right place, or you highlight the text. And you do that by just the same way you would highlight text and right shift then arrows and stuff. And then you either can go to the style menu and choose the one you want. Or you could win by entering it manually. I mean, like you would hit the command that pulls up the dialog box, enter your text and then you tab and click OK. So it's the reason I think your suggestion is better is is more that then you don't have to memorize how to how to what you have to type in for heading one cell centered you have to like it's very specific what you have to enter. So it's usually easier just to go to the menu. Right? Yeah. Okay, thank you.  
Betty Nobel   
First of all, thanks. This workshop is just been fabulous. One quick, quick question. Open your computer keyboard and it has been working with Duxbury now I probably know why and what to do, but the materials that are coming out for regarding today's presentation, quickly get them in Braille or not.  
Jen   
I was going to suggest that I thought hey, this is a Duxbury presentation I so I'm willing to I'm willing to do that or I mean Jennifer you want to do it that's fine with me. 
Diana Brent   
No, I would really really appreciate 
Betty Nobel   
that. And I'm happy to pay whatever has to be paid for for that but it's gonna be free from Braille. I Don't learn from other ways. 
Jen   
Yeah, no that's I was gonna Create My Route Are you are you okay with an electronic Braille file? Or do you want hardcopy? 
 
Betty Nobel   
I want hardcopy 
 
Jen   
okay well, we'll talk Can you can you email the info list? I want to be careful that I don't get us into something that we can't do but can you if you think of it and I'll try to remember to 
 
Betty Nobel   
whatever you're sending out in print if we can have that put in. Thank you. Yeah, okay, thanks a lot.  
This is great. 
 
Daphne Hitchcock   
I know good violates Myra. Now we have Deborah and Marie so Deborah, why don't you go 
 
Diana Brent   
ahead. 
 
Myra
 My question is for Gen G. So. you said that languages if you need to have a file if a document like with English in French in it. You need to change that in Word will change automatically in Duxbury because I know like I just contracted stuff manually if I have to. 
 
Jen   
That's an interesting one. I usually do it in Duxbury, but I I'm pretty sure that if you yes if you if you're in your Word file and you have a bilingual document and you highlight the French style and then word you change the language which you can do it then when you go into Duxbury the one thing you have to do, I forget where the setting is but I think it's in the word importer, you have to tell it to recognize different languages. You have to basically say I forget the wording but it's something like recognize what language change or something it's an obvious whatever the words are it's very interesting when you see it you'll know it and I I just can't remember off the top of  the word importer so what is that so is it like because I mean I just import the files like automatically i I don't really usually use the word importer like what is it?  
Jen   
So the word import is what you're doing is totally correct, it's just in Duxbury if you go into the global menu and you want to if this is one of those things like what Diana talked about where you open Duxbury you don't open a file you just hit all the menu go in the global option and go there's formatted Braille importer there's word there's Import Options now like they've changed the arrangement of it a bit but there's a word importer and you click on that and that's where it gives you all kinds of choices on how you how you want Duxbury to process the information that it gets from word 
 
Okay my other question; maybe you don't know this, but I have 12.4 right now and I want to update to whatever is the latest version. Do we have to go through a Canadian or can we go through Duxbury directly 
Jen   
You can go to Duxbury directly. 
Jen   
is very quick I don't want to comment like I don't want to Yeah, yeah, yeah, but I will say that Duxbury is very, very quick. So again, you just give them yourserial number and then I guess they will update it for you. 
Deborah
I just have a little one silly question. Do you need a Braille printer to have Duxbury? 
Jen   
No, you don't Oh, no, just if you want to emboss hardcopy, then you then you need a Braille embosser but if you just want to create electronic files and read them on a Braille display or send them to somebody else  
 
Diana Brent   
I was going to say for the person, maybe it was Bruce, who asked about the updated JavaScript file. I noticed if you wanted to use JAWS without speech, prior to the most recent script file, and I do this, sometimes if I'm just working on with my Braille display, and I don't want it to matter at me, it would automatically turn my speech on. And with the most recent JAWS it doesn't turn it on. It leaves them. It leaves the speech off.  
Jen   
I have a question for Gen. J. I was wondering if you read large print as well? Do you? Are there things in Duxbury that you find helpful as from that perspective? 
Jen Jesso   
There are some options in the View menu. So I, I use Duxbury with mostly JAWS and Braille. But I do often run screen magnification at the same time. When you're zoomed in, you can only see at least at the level of zoom that I use a very small portion of the screen at a time. And so it's really hard to stay oriented in terms of like, Am I at the top of the page at the bottom of the page. And so that's pretty has a feature in the View menu. I think it's under the View preferences menu, where you can turn on line numbers and this actually works with speech as well. And when line numbers are turned on, it will announce what line number you're on as you're arrowing through the document and it also displays them on either side of the page. So that is one feature I do find Wow. Well, I will say the latest version of Duxbury, I don't have the I have 12.5 I have 12.4 and I do find it's really bad quality. With magnification like with ZoomText, everything is all pixelated and doesn't look good. And I haven't I haven't actually contacted tech support to see you know how to sort that out. But there's definitely been a change in the last version or two of Duxbury, where large print and magnification do not work very well with it. So I don't know if that's just settings that need to be changed or whether it's a problem with Zoom Text on there. And and you can also change I think Jenny mentioned this, but you can change the text size as well. So if you need a larger font or if you find the font that's used in print, that's pretty files which is I think it's like career or it's like one of these like mono space, kind of thin fonts. If you find that hard to read, you can go in and change it to you know, for Donna or Arial or something that's a little bit easier for people with low vision. Okay, um, I will see to another feature I do find useful in ZoomText actually is ZoomText has what this is kind of off topic maybe. But ZoomText has a feature called a freeze view where you can have basically two areas of the screen in view at once. And in the past, I have set the freeze view to the translated line so that I'm able to see the Braille document and the translated line on the screen at the same time without having to scroll all around. But that has its limitations because it only shows the beginning of the line so it that's that's why I tend to just use Braille because the magnification just shows too little content. at a time, basically.  
Betty Nobel   
I just wanted to mention that if you want to create something in SimBraille, which is dots on paper for print users to see, let's say you were going to a school and you wanted to create a Braille alphabet, I believe you can do that in Duxbury, too. They have a SimBraille font that you can change it to, if you're, I think it's in a DXP document. And then you print printed out. And that can sometimes be useful if you're wanting to create something in Braille. Or even like secret messages or something. Have I got that right? Is that how you do it in Duxbury, you change the font to sim Braille in a DSP document, and then you can print it and will it come out as as Braille dots? 
 
Jen Jesso   
Oh, sorry, Jen. No, go ahead. I was gonna say I have not done it with a DSP file. But I have, I believe I have printed a DXB file on a printer, and it just prints out as just symbol. Yeah, the whole page will just be in Braille. But one thing, you do have to enlarge the font because the, if you're using the default symbol font that comes out kind of small. So if you want it to be actually the same size as a, you know, a Braille, you, I think you have to set it to 24 font for it to be the same size. A
 
Daphne Hitchcock   
It is very helpful when SimBraille is double spaced for sighted people reading some Braille because they're not used to it.  
Jen   
Another thing you can do; if you create a file in Duxbury, save it as a BRF, then you put it in Word. If you have some Braille fonts downloaded, you can then change your font to whatever Braille font you're using. And then you save it as a PDF. And then you've got, I've done that sometimes for people who are doing signage, and they need a PDF, and they need it to be the right scale, then you can do it that way.  
Betty Nobel   
I also wanted to mention that when you're setting Duxbury up and you're setting up an inbox, it can be a fairly complex process, so it's a good idea to get some help to set it up, because you have to set it up with a generic text only printer is what they used to call it, and I forget now, they call it something different in Windows 10, somebody Diana might remember. It is a bit of a challenge when setting up a Braille embosser. It's not just as easy as selecting the embosser from the global memory menu, and you're good to go. unless they've changed that in 12.5. I only am using 12.4 at the moment. 
Jen   
That's when I was talking earlier, about how before you set it up in Duxbury, you have to go like into your PC and add printers and devices. You have to do that first. 
Diana Brent   
Right. So, Diana, and I was also going to say that sometimes with the newer embossers You don't have to set up the text only printer. It really depends on the embosser. 
 
Betty Nobel   
Okay, so it's just the older embossers 
Kim Kilpatrick   
This may be too long a question for this workshop. But I just wonder in the day and age of when braille displays that we have, are able to read quite well many different document formats. Now word and other things. What are the benefits to using Duxbury? With a Braille like when would you use it as opposed to just slapping in a document like a Word doc or text up into your Braille display. 
Jen   
So I would love to hear what J thinks as well I use it when I really want the formatting to be good Braille formatting when I don't want to just leave my you know, iPhone and Braille display to do its thing. Or for really like math, higher level math you really need. If you really want to make sure it's precise, like there's certain kinds of documents so I don't know, Jen, what your thoughts are. 
Jen Jesso   
Yeah, I'm the same. I use it when I really need to make sure that it has good formatting. And also some of the Braille displays out there like I have a focus 14 blue. And that does not support any kind of Braille translation. So if I have a file that I want to put on there, I would use Duxbury to translate it first into a BRF. And then I would stick it on the Braille display. And I put some of the others like the orbits, and I think there's a few others that don't have any built in translation. 
Kim Kilpatrick   
Since I've used BrailleBlaster, I've just used BrailleBlaster for that, 
 
Jen Jesso   
I was actually wondering if we should mention it; Braille Blaster is an option as well for and it's free. It's open source. 
Kim Kilpatrick   
I find it easy to use. And thankfully, I heard a workshop that BLC did on it a few years ago. I think it's good. 
Just another upgrade question again. I have 12.4,is 12.5 that different?  
Jen   
I have Duxbury 12.5. And they fixed some bugs, I think they've also rearranged a few things in the menu. I keep forgetting to go, there's like a what's new in 12.5. And actually, even if you don't have 12.5, you can go to Duxbury website and read about what changes there are in 12.5 and decide whether it's worth it to you to upgrade or wait for bigger and better things. 

Okay. I know for updates like Jaws, if you don't update live within a certain time, your license expires, and then you have to pay the full price, right? 
Jen   
You have a certain number of I believe when you when you purchase Duxbury they'll do like releases, right? Duxbury will tell you what you're eligible for it's really it really depends on your license. 
Peg Mercer   
I'll be quick because it's just a sidebar thing. I was very interested Jen Goulden what your comment about WordPerfect which I know norm nobody is still in there, though. If WordPerfect is used, I keep getting advertisement from Corel about it. And I haven't actually put it on my system for years. But is it still I mean, has anybody used it at all or? 
 
Jen   
I haven't seen anyone use it in ages? Maybe in other parts of the world there are people you never know I've Duxbury is listed in there for a reason. 
 
Jen Jesso   
I just googled it in there is Word Perfect 2021. So obviously still use it. But yeah, I don't know anyone. 
 
Jen   
I love Word Perfect. Anyway. 
 
 
 
On the subject of why use Duxbury What are the other reasons I think is that JAWS and the orbit and most other devices these days use Lib Louis, which is of course a free Braille translator. And in some cases, you get what you pay for Duxbury is the gold standard when it comes to transcription and travel and translation. And so if you want a good transcription, your better bet is with Duxbury by personal opinion. 
Daphne Hitchcock   
Well, seeing no more raised hands. Thank you, Jen and Jen, for this thorough presentation; so much material covered. For those of you that participated, the handout will be coming your way when it's given a few updates, and there will be a transcript also of this meeting as well. We'll let you know when that's available on our website. Thank you both. Thank you, everyone.  
Jen Jesso   
Okay. Also I did I did want to say on the information that we're going to send out we are going to include information about a Duxbury mailing list. So if you do have other questions about Duxbury, or how to use JAWS with Duxbury, there are quite a fewJ AWS users on that list so that that is a good place to go and ask questions. 
Jen   
Thank you, everybody. Thank you very much. 
 
 

